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GRAPH MULTIPLE ANIMALS BY AGE

ZIMS has two graphing options to compare animal weights. The Weight Comparison Report (a global
resource) allows you to compare a graph of a single animal’s weight with the weights of other
animals in the global database of the same age and sex. The Animal Graphing Tool (a local tool)
allows you to view multiple animal weights with the x axis display by the date the weight was
recorded. Species360 would like to thank Sjoukje Vaartjes, ZAA Training Convenor and Species360
Adjunct Trainer for sharing her method for graphing multiple local animals by age using the data in
ZIMS.

Contact support@Species360.org

The Steps

Step 1: Prepare Your Data

S > Use the Animal Graphine Tool
- 3: Confi he C in Excel
Step 4: Create a Graph

The Scenario:
You had three red pandas born at your institution over a period of 17 years. You want to produce a
graph that will compare their growth rates over their first year.

Step 1: Prepare your data
1. The Unit of Measure must be the same for all animals and throughout the selected Date
Range.
2. Your date display preferences must be in numbers and not text. For example, 07/15/2006 and
not 15 Jul 2006. ZIMS will not export text as numbers and Excel will not recognize the text.
You can change this display in My Preferences > Language, Date/Time and Separator Formats.

Step 2: Use the Animal Graphing Tool
The Animal Graphing Tool is found under Start > Tools > Animal Graphing Tool.
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Enter Date Range, Animal IDs and select Animal Weight. In our scenario, the date range would start
with the Birth Date for the first red panda (July 9, 2001) and end with the date 1 year after the Birth

Date of the last red panda (June 12, 2019).
Animal Graphing Tool

meiehllnm Please Select

Date Range *

> a8 Bl

Animal(s) *

M18008/Ailurus fulgens fulgens/Red pandal...
XAG041/Allurus fulgens fulgens/Red pandal...

XFG005/Ailurus fulgens fulgens/Red pandal...

Search local animals

> Show Graph

7/9/2001 = 6/12/2019

Q

Measurement Type *

Animal Weight

Please Select

Click on Show Graph.
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Animal Weight

Print chart

Download Data in Excel

Bownload PHG image
Download JPEG image

M18008: XFGO0O0S: XAGD4T:

At first glance it looks like they grew at about the same rate, but we can do some data manipulating
to get a graph that compares their weights by age for the first year. Select the hamburger icon and
choose Download Data in Excel.

Back to The Steps

Step 3: Configure the data in Excel

When ZIMS downloads the data from Excel the rows are in order of newest to oldest. To create a
graph of oldest to newest you will need to resort the rows by oldest to newest. The easiest time to do
that is when you create separate sheets for each animal. Instructions to do this are included at that
step.

Enable Editing and remove the columns for Time, Measurement Type, UOM and Notes
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A C F G

Date Entity Value ote
06/13/2002 25733048/XAG04 Anifgal Weight 4600 "
05/07/2002 25733048/XAG04 Ani 4600
04/12/2002 25733048/XAG04 AnimaliWeight 4600
03/03/2002 25733048/XAG04 Animal "4900
02/13/2002 25733048/XAG04 Animal "4700
01/30/2002 25733048/XAG04 Animal Welght gram "4300
01/22/2002 25733048/XAG04 Animal Wei gram "4000
01/10/2002 25733048/XAG04 Animal Weig gram "4000
12/11/2001 25733048/XAG04 Animal Weight gram ’3200
12/03/2001 25733048/XAG04 Animal Weig gram "2980
11/28/2001 25733048/XAG04 Animal Wei gram "2200
11/24/2001 25733048/XAG04 Animal Wejght gram "2900.0
11/12/2001 25733048/XAG04 Animal ram "2570.0
11/06/2001 25733048/XAG04 Animal "2350.0
11/04/2001 25733048/XAG04 Anim. "2280.0
11/02/2001 25733048/XAG04 Ani "2220.0
10/31/2001 25733048/XAG04 Anifnal Weight "2100.0
10/29/2001 25733048/XAG04 "2110.0
10/27/2001 25733048/XAG04 Animal Weight gram "2030.0
10/25/2001 25733048/XAG04 Animal Weight gram "2000.0

A B (=
Date Entity o Value
06/13/2002 25733048/XAG041/XAG041/Ailur 4600
05/07/2002 25733048/XAG041/XAG041/Ailur 4600
04/12/2002 25733048/XAG041/XAG041/Ailur 4600
03/03/2002 25733048/XAGO41/XAGO41/Ai|Ur'4900
02/13/2002 25733048/XAG041/XAG041/Ai|UI"4700
01/30/2002 25733048/XAG041/XAG041/Ai|UI"4300
01/22/2002 25733048/XAG041/XAG041/Ai|ur'4000
01/10/2002 25733048/XAG041/XAG041/Ai|ur'4000
12/11/2001 25733048/XAG041/XAG04 1/Ai|ur'3200
12/03/2001 25733048/XAGO41/XAGO41/Ai|Ur'2980
11/28/2001 25733048/XAG041/XAG04 1/Ai|ur'2200
11/24/2001 25733048/XAG041/XAG04 1/Ai|ur'2900.0
11/12/2001 25733048/XAG041/XAG04 1/Ai|ur’2570.0
11/06/2001 25733048/XAG041/XAG04 1/Ai|ur’2350.0

Remove any rows for weights recorded on dates that are not desired. For example, our first red
panda was born July 9, 2001. We want to compare weights for the first year. We removed any rows
for dates after July 9, 2002 for that animal. If more than one weight was recorded on the same day,

remove one of them. There can be only one weight per day.

Alternate flow You will eventually need to make each record have the same number of rows. You can

do that now to save on the number of times you need to copy something, or follow the

recommended flow as detailed in this document.
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A B (€
L Date Entity Value
P 06/13/2002 XAG041 4600
B |05/07/2002 XAGO041 4600
H 04/12/2002 XAG041 4600
B 03/03/2002 XAG041 4900
b 02/13/2002 XAG041 4700
F 101/30/2002 XAG041 4300
B 01/22/2002 XAG041 4000
P 01/10/2002 XAG041 4000
0 12/11/2001 XAG041 3200
1 12/03/2001 XAG041 2980
2 11/28/2001 XAG041 2200
3 11/24/2001 XAG041 2900.0
4 11/12/2001 XAG041 2570.0
5 /11/06/2001 XAG041 2350.0
6 11/04/2001 XAG041 '2280.0
7 11/02/2001 XAG041 '2220.0

Replace Entity Details with Local ID.
This can quickly be done by copy
and paste.
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Insert a column to the left of Date and another one after Date. Column A will be Birth Date and
column C will be Age.

A
Birth Date

owoo~NoOundsWNEOT

B

Date

06/13/2002
05/07/2002
04/12/2002
03/03/2002
02/13/2002
01/30/2002
01/22/2002
01/10/2002
12/11/2001
12/03/2001
11/28/2001
11/24/2001
11/12/2001
11/06/2001
11/04/2001
11/02/2001
10/31/2001
10/29/2001
10/27/2001

Age

D E
Entity Value
XAG041 4600
XAG041 4600
XAG041 4600
XAG041 4900
XAG041 4700
XAG041 4300
XAG041 4000
XAG041 4000
XAG041 3200
XAGD41 2980
XAG041 2200
XAG041 '2900.0
XAG041 '2570.0
XAG041 '2350.0
XAG041 '2280.0
XAG041 "2220.0
XAG041 2100.0
XAG041 '2110.0
XAG041 2030.0

Record the Birth Date for each animal in column A. This is easily done by copy paste several at a time
if the list is long.

In the Age column (C), enter the following formula in the first row:

=DATEDIF(A2,B2,"y") & "y" & DATEDIF(A2,B2,"ym") & "m" & DATEDIF(A2,B2,"md") & "d"

This will convert the date that the weight was taken against the date of birth and return the age of
the animal as of that date.

It is the mission of Species360 to facilitate international collaboration in the collection and sharing of
information on animals and their environments for zoos, aquariums and related organizations.

www.Species360.org — Global Information Serving Conservation


mailto:support@species360.org
http://www.species360.org/
https://www.facebook.com/Species360
https://twitter.com/species360
https://www.linkedin.com/company/species360
https://www.species360.org/blog/

SPECIES

360

Contact Us!

Global information
Follow Us!

serving conservation.

A B C D E
Birth Date Date Age Entity Value
7/9/2001 06/13/2002 0Oy11m4d XAG041 4600
7/9/2001 05/07/2002 XAG041 4600
7/9/2001 04/12/2002 XAG041 4600
7/9/2001 03/03/2002 XAG041 4900
7/9/2001 02/13/2002 XAG041 4700
7/9/2001 01/30/2002 XAG041 4300
7/9/2001 01/22/2002 XAG041 4000
7/9/2001 01/10/2002 XAG041 4000
7/9/2001 12/11/2001 XAG041 3200
7/9/2001 12/03/2001 XAG041 2980
Ziniannd 14 /A0 /anmnd MWNAMCNAA "')")ﬁﬁ

There are two ways to convert the remainder of the Age column. Way 1 is to left click on the cell with
the age, grab the lower right hand corner and drag down row by row. The correct age will be
calculated for each row.

A B C D E
L Birth Date Date Age Entity Value
P |7/9/2001 06/13/2002 Oy11m4d XAG041 4600
B |7/9/2001 05/07/2002 0y9m28d XAG041 4600
4 |7/9/2001 04/12/2002 0y9m3d XAG041 4600
b |7/9/2001 03/03/2002 0y7m22d XAG041 4900
5 |7/9/2001 02/13/2002 0y7m4d XAG041 4700
y 7/9/2001 01/30/2002 =:\G041 4300
B 7/9/2001 01/22/2002 XAG041 4000
B 7/9/2001 01/10/2002 XAG041 4000
0 7/9/2001 12/11/2001 XAG041 3200
1 7/9/2001 12/03/2001 XAG041 :2980

Way 2 is to left click on the cell with the age, hold the shift key and scroll to the bottom of the column
highlighting the entire column. Select Fill (upper right) and Down.

It is the mission of Species360 to facilitate international collaboration in the collection and sharing of
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The entire age column will be populated with the correct ages.

6/6/2006
6/6/2006
6/6/2006
6/6/2006
6/6/2006
6/6/2006
6/6/2006
6/6/2006
6/6/2006
6/6/2006
6/6/2006
6/6/2006
6/6/2006
6/6/2006
6/6/2006

O OO NOoO R WNRFROWOOYTO O R WM

06/21/2006
06/20/2006
06/19/2006
06/18/2006
06/17/2006
06/1¢/2006
06/15/2006
06/14/2006
06/13/2006
06/12/2006
06/11/2006
06/10/2006
06/09/2006
06/08/2006
06/07/2006

As of 11/19/2019

Oy0m15d
Oy0m14d
Oy0m13d
Oy0m12d
Oy0m1ld
Oy0m10d
O0y0m9d
Oy0m8&d
Oy0m7d
Oy0m6d
Oy0m5d
Oy0m4d
0y0m3d
OyOm2d
Oy0m1d

© 2019 Species360

XFGO005
XFGO005
XFGO005
XFGO005
XFGO005
XFGO005
XFGO005
XFGO005
XFGO005
XFGO005
XFGO005
XFGO005
XFGO005
XFGO005
XFGO005

'334.7
"315.7
'317.0
'302.5
'280.5
262.7
"238.7
'232.5
222.6
203.8
"197.2
172.5
"157.7
"140.6
"130.7
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Copy each animal into their own worksheet so that they are separated. You can name each sheet by
the identifier that you prefer. It is recommended that you keep the master worksheet with all the

animals in case you need to redo one of the single animal worksheets.
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XAGO41  2030.0
XAG041 2000.0
XAG041 1960.0
XAG041 1910.0
XAG041 1850.0
XAG041 1800.0
XAG041 :1700.0

10/27/2001 Oy3m18d
1 10/25/2001 Oy3mléed
» |10/23/2001  0y3m14d
8 10/21/2001 Oy3ml2d
1 10/19/2001 Oy3m10d
5 10/18/2001 Oy3mod
5 |10/15/2001 0y3méd
e CTAl -Daisy Marie | Cyril

=
L+ 1
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Add a row for column headers if needed. Rename the column headers for the individual animal
sheets as needed. What you record for the header in the weight column is what will display in the
graph. Delete the Entity column as it is no longer needed. DO NOT delete the Birth Date or the Date
column, even though they are not needed for the graph, as the Age column is calculated from them.

A

6/6/2006
6/6/2006
6/6/2006
6/6/2006
6/6/2006
6/6/2006
6/6/2006
6/6/2006
6/6/2006
6/6/2006
6/6/2006
6/6/2006
6/6/2006
6/6/2006
5 |6/6/2006
7 16/6/2006

o Fondl ol s W n ¥ W i

T T T

B

Birth Date Date

03/17/2007
12/07/2006
11/29/2006
11/11/2006
10/31/2006
10/16/2006
10/14/2006
10/09/2006
10/07/2006
10/04/2006
10/01/2006
09/29/2006
09/27/2006
09/25/2006
09/23/2006
09/19/2006

faYa Wi B B iaTalal -

€
Age
Oy9mlld
Oy6mld
Oy5m23d
Oy5m5d
Oy4m25d
Oy4m10d
Oy4m8d
Oy4m3d
Oy4mld
Oy3m28d
Oy3m25d
Oy3m23d
Oy3m21d
Oy3m19d
0y3ml7d
Oy3ml3d

D E
Daisy Weight
4628

3280

3300

3000

2630

2300

2240

2060

2040

2020

1930

1890

1870

"1800

1760

1660

'-I fodin W

This is a good time to reorder your rows to be oldest to newest if you haven’t already. Select the Age

column, select Data from the top menu bar and select Text to Columns.

It is the mission of Species360 to facilitate international collaboration in the collection and sharing of
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Page Layout Formulas Review View

B, Show Queries ty  [£] Connections Al Z A
T 1= ool - Tvn ] i) el
her Existing New = Refresh JZ\L Sort Filter Textto [Flash
s~ Connections  Query~ LORecent Sources - dit Links W Advanced | coumns | Fil
o Get & Transform Connections Sort & Filter

S

o [ c ] o & r o u

e Age Daisy Weight
17/2007 0y9m11d 4628
07/2006 Oy6m1d 3280

20/2006  OySm23d 3300
16/2006  oyimiod 2300
14/2006  Oy4msd 2240
09/2006  0y4m3d 2060
07/2006 Oydm1d 2040
29/2006  Oy3m23d 1890
25/2006  Oy3misd 1800
23/2006  oydmi7d 1760
17/2006  oy3mlld 1620
15/2006  0Oy3m9d "1560

12/2006A PAEWCY "1enn

Choose Delimited and Next, Next, Finish.

Convert Text to Columns Wizard - Step 10of 3 ? X

The Text Wizard has determined that your data is Fixed Width.
If this is correct, choose Next, or choose the data type that best describes your data.
Original data type
3 pe that best describes your data:

Characters such as commas or tabs separate each field.

- Fields are aligned in columns with spaces between each field.

Preview of selected data:

fge
DATEDIF (A2,B2,"y") & "y" & DATEDIF(A2,B2,"ym") & "m" & DATEDIF (A2,B2,"md") & "d"
DATEDIF (A3,B3,"y") & "y" & DATEDIF(A3,B3,"ym") & "m" & DATEDIF (A3,B3,"md") & "d"
|4 }paTEDIF(Re, B4, "y") & "y" & DATEDIF(A4,B4,"ym") & "m" & DATEDIF (A4,B4,"md") & "d"
[skDATEDIF(25,B5,"y") & "y" & DATEDIF(AS,BS,"ym") & "m" & DATEDIF (AS,BS,"md") & "d"
|&|DaTEDIF (36, B6, "y") & "y ¢ DATEDIF(R6,BE,"ym") & "m" & DATEDIF (R6,B6,™md") & "d" |w

< >

Cancel I Mext > I Einish

Do this for the Date and Weight columns as well and repeat for all animals. This will allow you to sort
oldest to newest.

To reorder, select the Date column, select the Data tab and select Sort.

It is the mission of Species360 to facilitate international collaboration in the collection and sharing of
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File Home Insert Page Layout Formulas 3 Review View Q Tell me what you want to dc

D F [ Show Queries annections a|

1 - )
E FE% FE?E Fron%er Existing New Dme fable Refr::h PropertieS Sort Filtd
cess Web Text Sources~ Connections Query~ [ Recent Sources | - Edit Links A

I,\\) Get External Data Get & Transform Connections Sort
il - Je Date
A B C D E F

Ll |Birth Date| Date Age Cyril Weight

P |7/9/2001 6/13/2002 |0y11m4d 4600

B |7/9/2001 4/12/2002 |0y9m3d 4600

i |7/9/2001 3/3/2002 |oy7m22d 4900

b |7/9/2001 2/13/2002 |0y7m4d 4700

b |7/9/2001 1/22/2002 [0y6m13d 4000

¥ |7/9/2001 12/11/2001 |oysm2d 3200

B |7/9/2001 12/3/2001 |oy4m24d 2980

P |7/9/2001 11/28/2001 |0y4m19d 2200

0 17/9/2001 11/24/2001 |oy4m15d 2900

117/9/2001 11/6/2001 |oy3m28d 2350
217/9/2001 11/2/2001 lov3m24d 2220
Select Expand the selection and then Sort.

e el | i o N e [T T IIT LR - A
Sort Warning ? X

Microsoft Excel found data next to your selection. Since you have not selected this data, it will
not be sorted.

What do you want to do?

O Continue with the current selection

Sort... Cancel
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Select to sort by date, order Oldest to Newest and select OK. Your rows should now be displayed

with the oldest records on the top.

L Sort ? X

i +§l Add Level xgelete Level E@ Copy Level Options... My data has headers
: Column Sort On Order

f |sonby I | [vaes v [oetio veves v
Ba AnIng s~ o amanl
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To create a graph, the number of rows you want to graph for each animal needs to be the same, so
you may need to do a bit of deleting to get the number of rows to match. Alternately, you can add a
filter to the column headers and select the dates you want.

Alternate Flow

You can do this deleting before you record the Birth Date, change Entity to Local ID or perform the
Age calculation to reduce the number of times you have to copy something, but it is recommended to
work with the single animal worksheets to do this.

Back to standard flow

Daisy had 109 weights, Marie had 70 weights and Cyril had 116 weights. To make the number of rows
match we need to delete 39 rows from Daisy and 46 rows from Cyril. Some recommendations for
determining what rows to delete are:
e Don’t delete any rows with weights that don’t appear to be following the progression as they
may be an indicator of other issues to consider and you may want that weight displayed.
e If weights were recorded several days in a row and then not until a week later, remove some
of the rows for the daily weights.
e If weights remain the same over a period of time, keep the first and last weight and remove
the ones in between.
e Otherwise, remove rows at even intervals to maintain the progression.

Copy each animal into a new sheet or copy the other animals into an existing individual sheet. Double
check that your number of rows is the same for each animal.

A B € D E F G H I ] K L
Birth Date Date Age Daisy Weight ~ Birth Date Date Age Marie Weight Birth Date Date Age Cyril Weight
6/6/2006 6/7/2006 0y0m1d 130.7 6/12/2018 6/13/2018 oyomid 103 7/9/2001 7/9/2001 oyomod 127
6/6/2006 6/9/2006 0yom3d 157.7 6/12/2018 6/14/2018 oyom2d 106 7/9/2001 7/10/2001 oyom1d 121.5
6/6/2006 6/11/2006 0y0msd 197.2 6/12/2018 6/15/2018 oyom3d 120 7/9/2001 7/11/2001 oyom2d 120.8
6/6/2006 6/12/2006 0y0méd 203.8 6/12/2018 6/16/2018 0ydm4d 133 7/9/2001 7/13/2001 0y0m4d 138
6/6/2006 6/14/2006 0y0msd 232.5 6/12/2018 6/17/2018 oyomsd 147 7/9/2001 7/14/2001 oyomsd 142.6
6/6/2006 6/15/2006 0y0mod 238.7 6/12/2018 6/18/2018 0yom6d 164 7/9/2001 7/17/2001 Oy0msd 174.4
6/6/2006 6/17/2006 0yomi1d 280.5 6/12/2018  6/19/2018 0oyom7d 179 7/9/2001 7/18/2001 oyomod 189.2
6/6/2006 6/18/2006 0y0m12d 302.5 6/12/2018 6/20/2018 0y0msd 197 7/9/2001 7/19/2001 oyom1od 198
6/6/2006 6/20/2006 0y0m14d 315.7 6/12/2018 6/22/2018 0y0m10d 218 7/9/2001 7/21/2001 0y0ml2d 223
6/6/2006 6/21/2006 0ydm15d 334.7 6/12/2018 6/24/2018 oy0omi2d 248 7/9/2001 7/23/2001 o0y0oml4d 246.5
P 16/6/2006 6/24/2006 0y0m18d 378.7 6/12/2018 6/25/2018 0y0m13d 254 7/9/2001 7/24/2001 oydm1sd 251.3
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b 6/6/2006 6/28/2006 oy0m22d 440.1 6/12/2018 6/27/2018 oyomi5d 272 7/9/2001 7/31/2001 oyom22d 312.9
b 6/6/2006 6/30/2006 0y0m24d 467.5 6/12/2018 6/29/2018 0y0m17d 298 7/9/2001 8/1/2001 oyom23d 321
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Step 4: Create a Graph

Select the Age and Weight columns for the first animal, hold the Ctrl key down and select those
columns for the other animal(s).

A B . D E | B G H I | ] K L M

Birth Date Date Age Daisy Weight  Birth Date Date Age Marie Weight Birth Date Date Age Cyril Weight

6/6/2006 6/7/2006 Oyomid 130.7 6/12/2018 6/13/2018 Gyomld 103 7/9/2001 7/9/2001 Gy0mod 127
6/6/2006 6/9/2006 0Oydm3d 157.7 6/12/2018 6/14/2018 0yom2d 106 7/9/2001 7/10/2001 Oy0mld 121.5
6/6/2006 6/11/2006 OyomSd 197.2 6/12/2018 6/15/2018 oydm3d 120 7/9/2001 7/11/2001 oyom2d 120.8
6/6/2006 6/12/2006 Oy0mé6d 203.8 6/12/2018 6/16/2018 Oydmdd 133 7/9/2001 7/13/2001 Oy0mdd 138
6/6/2006 6/14/2006 oyom8d 232.5 6/12/2018 6/17/2018 oydmsd 147 7/9/2001 7/14/2001 oyomsd 142.6
6/6/2006 6/15/2006 Oyomod 238.7 6/12/2018  6/18/2018 0ydm6d 164 7/9/2001 7/17/2001 0yomsd 174.4
6/6/2006 6/17/2006 0Oyomild 280.5 6/12/2018  6/19/2018 0yom7d 179 7/9/2001 7/18/2001 0y0mod 189.2
Il Ao Talal AMRMIONA feaie 133 2ANIE £/12/2N19 A/2N/N18 A0 107 7/0/2001 /102001 A1 109

Select a line chart from the Insert tab.
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To edit the graph, click on the chart and choose Design > Select Data from the Chart Tools menu.
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Make sure that only the weight series are checked. Select OK.
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, Add Chart Element.
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And you are done!!!l The red pandas gained almost the identical weight at the beginning. You can

review their records to determine what may have contributed to the differing weight gain towards
the end of their first year.
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